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Important User Information

Because of the variety of uses for the products described in this
publication, those responsible for the application and use of this control
equipment must satisfy themselves that all necessary steps have been
taken to assure that each application and use meets all performance and
safety requirements, including any applicable laws, regulations, codes
and standards.

The illustrations, charts, sample programs and layout examples shown in
this guide are intended solely for purposes of example. Since there are
many variables and requirements associated with any particular
installation, Allen-Bradley does not assume responsibility or liability (to
include intellectual property liability) for actual use based upon the
examples shown in this publication.

Allen-Bradley publication SGI-1.1, Safety Guidelines for the
Application, Installation and Maintenance of Solid-State Control
(available from your local Allen-Bradley office or online at
http://www.ab.com/manuals/gi), describes some important differences
between solid-state equipment and electromechanical devices that
should be taken into consideration when applying products such as those
described in this publication.

Reproduction of the contents of this copyrighted publication, in whole or
part, without written permission of Rockwell Automation, is prohibited.

Throughout this manual we use notes to make you aware of safety
considerations:

Attention statements help you to:

• identify a hazard

• avoid a hazard

• recognize the consequences

Important: Identifies information that is critical for successful
application and understanding of the product.

!
ATTENTION: Identifies information about practices or circumstances
that can lead to personal injury or death, property damage or economic
loss.

TIP: Identifies information that is helpful, but not necessary, in
completing a task.



Summary of Changes

The information below summarizes the changes to the serial converter
and documentation since its last release.

Serial Converter Changes

The 1203-SSS Smart Self-powered Serial Converter (FRN 3.xxx) can
now be used with products implementing DPI™ in addition to products
implementing SCANport™. DPI is a functional enhancement to
SCANport and is used by some Allen-Bradley products, including those
in the PowerFlex™ family of drives.

Use the following software versions with the 1203-SSS (FRN 3.xxx) to
fully utilize DPI host products such as PowerFlex Drives:

The following software versions can be used with the 1203-SSS (FRN
3.xxx) to fully utilize SCANport host products such as the 1305, 1336
PLUS II, etc.:

Documentation Changes

This manual supersedes Publication 1203-5.15 - August 1999. It
contains all information that was in that manual. In addition, it contains
the following changes and new information:

Software Version
DriveExplorer™ v2.01 or higher
DriveTools 2000™ v1.xx or higher

Software Version
DriveExplorer v1.01 or higher
DriveTools32™ v2.01 or higher

Location Description of Changes
Chapter 1 Information about DPI products has been added. In addition, information

has been rearranged.
Chapter 3 Instructions for using the PowerFlex HIM to access serial converter

parameters have been added.
Chapter 4 Events on DPI connections have been added.
Appendix B Parameters have been updated to reflect the changes to the serial

converter parameters.
Appendix C New flash instructions have been added to describe flashing PowerFlex

drives and peripherals.
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Notes:
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Preface

About This Manual

Read this preface to become familiar with the rest of the manual.

Documentation can be obtained online at http://www.ab.com/manuals.

The following conventions are used throughout this manual:

• Parameter names follow the format Parameter xxx - [*]. The xxx
represents the parameter number. The * represents the parameter
name. For example, Parameter 01 - [Adapter Port].

• Menu commands are shown in bold type face and follow the format
Menu > Command. For example, if you read “Select File > Open,”
you should click the File menu and then click the Open command.

• The firmware release is displayed as FRN X.xxx. The “FRN” is the
Firmware Release Number. The “X” represents the Major Release
Number. The “xxx” represents the Minor Release Number. This
manual is for Firmware releases 3.xxx.

Topic Page
Related Documentation P-1
Conventions Used in this Manual P-1
Rockwell Automation Support P-2

Related Documentation

For Information On: Refer to: Publication
DF1 Protocol DF1 Protocol and Command Set Reference manual 1770-6.5.16
DriveTools 2000 DriveTools 2000 Online Help –
DriveTools32 DriveTools32 Getting Started Manual 9303-5.23
DriveExplorer DriveExplorer Getting Results Manual 9306-5.2

Conventions Used in this Manual
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Rockwell Automation offers support services worldwide, with over 75
sales/support offices, over 500 authorized distributors, and over 250
authorized systems integrators located through the United States alone.
In addition, Rockwell Automation representatives are in every major
country in the world.

Local Support

Contact your local Rockwell Automation representative for:

• Sales and order support.

• Technical training.

• Warranty support.

• Support service agreements.

Technical Assistance

If you need to contact Rockwell Automation for technical assistance,
please review the information in Chapter 4, Troubleshooting first. If you
still have questions, then contact your local Rockwell Automation
representative.

Rockwell Automation Support



Chapter 1

Getting Started

The 1203-SSS serial converter provides an electronic communications
interface between a computer and any Allen-Bradley product
implementing SCANport or DPI. It uses the full-duplex, RS-232 DF-1
protocol.

Figure 1.1   Components of the Serial Converter

Topic Page Topic Page
Components 1-1 Safety Precautions 1-4
Features 1-2 Quick Start 1-5
Compatible Products 1-2 Modes of Operation 1-6
Required Equipment 1-3

Components

AB

�

��

�

�

# Part Description
� SCANport/DPI

Connection
Standard SCANport/DPI 8-pin circular mini-DIN connector.
The 1202-C10 cable is plugged into this connector.

� Status Indicators LEDs that indicate module operation, data is being received
from the computer, and data is being sent to the computer.
Refer to Chapter 4, Troubleshooting, for more information.

� RS-232 Serial Port Locking low profile connector. The 1203-SFC serial cable is
plugged into this connector.

� 1202-C10 Cable SCANport/DPI cable (1 m) with male-to-male connectors.
� 1203-SFC Serial

Cable
Serial cable (2 m) with a locking low profile connector to
connect to the serial converter and a 9-pin sub-miniature D
female connector to connect to a computer.
Tip: This cable can also be used to make a serial
connection to a 1203-CN1 ControlNet™ module or
1203-GU6 DeviceNet™ module.

Not
Shown

DriveExplorer Lite
CD-ROM

CD including DriveExplorer Lite software and
documentation.
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Features of the serial converter include the following:

• Three status indicators (LEDs) report the operating status of the
module.

• Serial baud rates of 9600 bps, 19.2Kbps, and 38.4Kbps are
supported. 9600 bps is the factory default.

• The serial converter can connect to products implementing
SCANport such as 1336 PLUS II drives, or products implementing
DPI such as PowerFlex drives. When used with a product, the serial
converter will autobaud to the SCANport or DPI data rate that is
used by the product.

• The serial converter receives power from the connection to the
product. An outside power source is not needed.

• DriveExplorer (DPI products require version 2.01 or higher),
DriveTools 2000 (version 1.xx or higher), or terminal emulation
software can be used to configure a serial converter. In addition, a
PowerFlex HIM can be used to configure a serial converter that is
connected to a PowerFlex drive or other DPI product.

The serial converter can be used with Allen-Bradley products that
implement SCANport or DPI.

SCANport products include the following:

DPI products include the following:

Features

Compatible Products

 Product  Product
1305 AC Drive (Drive firmware 2.01 or later) 1394 Motion System
1336 FORCE™ Drive 1397 DC Drive
1336 IMPACT™ Drive 1557 Medium Voltage Drive
1336 PLUS Drive 2364 Regenerative DC Bus Supply Unit
1336 PLUS II Drive SMC Dialog Plus™
1336 REGEN Line Regeneration Package SMP-3 Smart Motor Protector
1336 SPIDER Drive

Product Product
PowerFlex 70 Drive PowerFlex 7000 Drive
PowerFlex 700 Drive
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Equipment Shipped with the Serial Converter

When you unpack the serial converter, verify that the package includes:

User-Supplied Equipment

To configure the serial converter, you must use one of the following:

Required Equipment

❑ One Smart Self-powered Serial converter
❑ One 1203-SFC serial cable
❑ One 1202-C10 cable
❑ One DriveExplorer Lite CD
❑ This manual

❑ DriveExplorer software
DPI products require DriveExplorer version 2.01 or greater.
SCANport products work with all versions of DriveExplorer.

❑ DriveTools 2000 software (version 1.xx or greater).
❑ PowerFlex HIM (only if using a PowerFlex drive or other DPI

product).
❑ Terminal emulation software such as HyperTerminal.
❑ VT-100 compatible terminal.



1-4 Getting Started

Please read the following safety precautions carefully.

Safety Precautions

!
ATTENTION: Risk of injury or equipment damage exists. Only
personnel familiar with drive and power products and the associated
machinery should plan or implement the installation, start-up,
configuration, and subsequent maintenance of the product using a serial
converter. Failure to comply may result in injury and/or equipment
damage.

!
ATTENTION: Risk of injury or equipment damage exists. If the serial
converter is transmitting control I/O to the product (indicated by a solid
green diamond LED), the product may fault when you remove or reset
the serial converter. Determine how your product will respond before
removing or resetting a connected serial converter.

!
ATTENTION: Risk of injury or equipment damage exists.
Parameter 4 - [Comm Flt Action] lets you determine the action of the
serial converter and connected product if DF1 serial communications
are disrupted. By default, this parameter faults the product. You can set
this parameter so that the product continues to run. Precautions should
be taken to ensure that the setting of this parameter does not create a
hazard of injury or equipment damage.

!
ATTENTION: Risk of injury or equipment damage exists. DPI or
SCANport host products must not be directly connected together via
1202 cables. Unpredictable behavior due to timing and other internal
procedures can result if two or more devices are connected in this
manner.
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This section is designed to help experienced users start using the serial
converter. If you are unsure how to complete a step, refer to the
referenced chapter.

Figure 1.2   Example Serial Connection to a Computer

Figure 1.3   Example Serial Connection to a Hand-Held Computer

Quick Start

Step Action Refer to
1 Review the safety precautions for the serial converter. Throughout This

Manual
2 Install the serial converter.

Connect a 1202-C10 cable to the serial converter and a
compatible product. Then, connect a 1203-SFC serial cable to
the serial converter and a computer. Make sure that power
has been applied to the DPI or SCANport product.

Chapter 2,
Installing the
Serial Converter

3 Configure the serial converter parameters.
Use one of the following to configure parameters in the serial
converter:
• DriveExplorer (1)

• DriveTools 2000 (v1.xx or greater)
• PowerFlex HIM
• Terminal emulation software
• VT-100 compatible terminal

(1) Products implementing DPI require version 2.01 or greater. Products implementing
SCANport can use version 1.01 or greater.

Chapter 3,
Configuring the
Serial Converter

Product Serial
Converter

Computer

1202-C10
Cable

1203-SFC
Cable

PWR

STS

PORT

MOD

NET A

NET B

Product Serial
Converter

1203-SNM
Null Cable
Converter

(sold separately)

Hand-Held
Computer

1202-C10
Cable

1203-SFC
Cable

Serial
Cable
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Figure 1.4   Status Indicators on the Serial Converter

The serial converter reports its status using status indicators (Figure 1.4).
The following table describes the state of the status indicators under
normal operation:

If the diamond status indicator is red, there is a problem. Refer to
Chapter 4, Troubleshooting.

Modes of Operation

# Status Indicator State Description
� Diamond Flashing Green Serial converter is connected to a product

implementing SCANport or DPI.
Solid Green Serial converter is or was receiving I/O.

Removing or resetting the serial converter
may cause a serial fault in the product. On
DPI based products a “Soft Logout” can be
performed allowing removal of the converter
without a fault occurring.

Tip: To remove the adapter without faulting
the drive, set the logic mask in the drive to
ignore the adapter and then verify that the
drive is receiving its Logic Command and
Reference from another source.

Off No power or Flash operation in progress.
� TX Off Not transmitting data.

Flashing Green Transmitting data.
� RX Off Not receiving data.

Flashing Green Receiving data.

AB

�
�
�
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Installing the Serial Converter

Chapter 2 provides instructions for installing and removing the serial
converter.

The following cables are all you should need to connect the serial
converter to a product and computer.

Figure 2.1   Cables

Important: To provide proper termination of the serial cable shield, the
chassis of the computer should be properly grounded. If it is
not possible or practical to ground this, then a ground wire
should be connected to the serial cable shield at the shell of
the 9-pin sub-miniature D connector.

Topic Page
Selecting Cables 2-1
Installing the Serial Converter 2-2
Removing the Serial Converter 2-2

Selecting Cables

Number Description Catalog Number
� SCANport/DPI cable to connect the serial converter

to a drive.
1202-C10

� Serial cable to connect the serial converter to the
computer.

1203-SFC

� If you are connecting the serial converter to an H/PC
(handheld PC), you must use a null modem cable
with two male 9-pin sub-miniature D connectors.
These must be purchased separately.

1203-SNM
(sold separately)

� �

�
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1. Connect the serial converter to the product using the 1202-C10 cable.

Figure 2.2   Connecting a 1202-C10 Cable to the Serial Converter

2. Connect the converter to the computer using the 1203-SFC cable.

Figure 2.3   Connecting a 1203-SFC Cable to the Serial Converter

3. Verify that power is applied to the product. The serial converter
receives power from the product, so the product must be powered
before the serial converter will operate.

The diamond light on the serial converter flashes green to indicate that
the serial converter is properly installed and receiving power. If it is not
green, refer to Chapter 4, Troubleshooting.

1. Disconnect the 1202-C10 cable from the product and then from the
converter. To disconnect it, gently push it in and then pull it out.

2. Disconnect the 1203-SFC serial cable from the serial converter and
then the computer.

Installing the Serial Converter

RX

TX

RX

TX

Removing the Serial Converter

!
ATTENTION: Risk of injury or equipment damage exists. If the serial
converter is transmitting control I/O to the product (indicated by a solid
green diamond LED), the product may fault when you remove or reset
the serial converter. Determine how your product will respond before
removing or resetting a connected serial converter.
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Configuring the Serial Converter

Chapter 3 provides information about configuring the serial converter.

For a list of parameters, refer to Appendix B, Serial Converter
Parameters. For definitions of terms in this chapter, refer to the Glossary.

The serial converter stores parameters and other information in its own
Non-Volatile Storage (NVS). You must, therefore, access the serial
converter to view and edit its parameters. The following table lists tools
that you can use to access the serial converter and edit its parameters.

Topic Page
Configuration Tools 3-1
Using the PowerFlex HIM 3-2
Using DriveExplorer 3-3
Using Terminal Emulation Software 3-4
Setting the Serial Port Rate 3-8
Setting the Fault Action 3-9
Resetting the Serial Converter 3-10

Configuration Tools

Tool Refer To
DriveExplorer software(1)

(1) Products implementing DPI require version 2.01 or greater. Products implementing
SCANport can use version 1.01 or greater.

page 3-3 in this manual
DriveTools 2000 software (version 1.xx or greater) Documentation for the software
PowerFlex HIM page 3-2 in this manual
Terminal emulation software page 3-4 in this manual
VT100-compatible terminal Documentation for the terminal
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If you connect to a PowerFlex drive and it has either an LED or LCD
HIM (Human Interface Module), you can use the HIM to access and edit
parameters in the serial converter as shown below. It is recommended
that you read through the steps for your HIM before performing the
sequence. For additional HIM information, refer to your PowerFlex
Drive User Manual or the HIM Quick Reference card.

LED HIM Quick Start

LCD HIM Quick Start

Using the PowerFlex HIM

Step Key(s) Example Screens
1. Press ALT and then Sel (Device)

to display the Device Screen.

2. Press the Up Arrow or Down
Arrow to scroll to the serial
converter. Letters represent files
in the drive, and numbers
represent ports. The converter is
usually connected to port 2 (the
external port) and sometimes to
port 3 (available with a splitter).

3. Press the Enter key to enter your
selection. A parameter database
is constructed, and then the first
parameter is displayed.

4. Edit the parameters using the
same techniques that you use to
edit drive parameters.

Step Key(s) Example Screens
1. In the main menu, press the Up

Arrow or Down Arrow to scroll to
Device Select.

2. Press Enter to enter your
selection.

3. Press the Up Arrow or Down
Arrow to scroll to 1203-SSS.

4. Press Enter to select the serial
converter. A parameter database
is constructed, and then a menu
for the serial converter is
displayed.

5. Edit the parameters using the
same techniques that you use to
edit drive parameters.

OR

ALT Sel

Device

Parameter
Number

Port Number

OR

OR

F-> Stopped M

0.00 Hz

Main Menu:
Diagnostics
Parameter
Device Select

Port 2 Device

1203-SSS

Main Menu:
Diagnostics
Parameter
Device Select
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With DriveExplorer software, you can edit parameters in both the serial
converter and the connected product. On a PowerFlex drive (or other
DPI product), you can also edit parameters in any of the attached
peripherals. DriveExplorer Lite is shipped with the serial converter. It is
a free, limited-feature version of DriveExplorer.

DriveExplorer Lite Quick Start

This section is designed to help users start using DriveExplorer Lite. If
you are unsure how to complete a step, refer to the online help (select
Help > Help Topics) or the DriveExplorer Getting Results Manual,
Publication 9306-5.2, which is included on the CD.

Figure 3.1   DriveExplorer

Using DriveExplorer

Step
1 Select Explore > Configure Communication. Select the communications port

and baud rate that you are using. Select either checksum and accept the default
time for the time-out.

2 Select Explore > Connect > Local. A node eventually appears under Devices.
3 In the left pane, click the + signs to expand the tree. Click the product or serial

converter to display parameters in the right pane. Double-click a parameter to edit
it.
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This section provides detailed instructions on how to use terminal
emulation software to access the serial converter so that you can view
and edit serial converter parameters or view the serial converter event
queue.

A variety of terminal emulation programs can be used to establish a
serial connection between a computer and the serial converter. The
following instructions describe how to establish the initial serial
connection to the serial converter using a computer running
HyperTerminal—terminal emulation software provided with most
Windows operating systems.

Important: The following instructions use screen captures from
Windows 95 HyperTerminal. If you are using Windows
NT™ or Windows 98 HyperTerminal, screens may differ.

To use HyperTerminal to access the serial converter

1. Verify that the serial converter is installed correctly. Refer to Chapter
2, Installing the Serial Converter.

2. On the Windows 95 desktop, click the Start button, and then select
Programs > Accessories > HyperTerminal to display the
HyperTerminal dialog box (Figure 3.2).Your dialog box may look
slightly different.

On the Windows NT desktop, click the Start button, and then select
Programs > Accessories > HyperTerminal to display the
Connection dialog box (Refer to Figure 3.3). Then, go to step 6.

Figure 3.2   HyperTerminal Dialog Box in List View

3. Double-click Hypertrm.exe.

Using Terminal Emulation Software
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The Connection Description dialog box appears in the HyperTerminal
workspace.

Figure 3.3   Connection Dialog Box

4. In the Name box, type any name (for example, converter), and then
select any icon in the Icon box.

5. Click OK to display the Phone Number dialog box.

6. In the Connect Using box, select the communications port that you
intend to use (usually COM1 or COM2).

7. Click OK to display the Properties dialog box.
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8. Select the settings shown in Figure 3.4.

Important: If you have previously set Parameter 03 - [DF1 Rate
Cfg] to 19.2K or 38.4K, select that value in the Bits per
second box.

Figure 3.4   Properties Dialog Box

9. Click OK. A blank HyperTerminal workspace appears.

10. Select File > Properties to display the Properties dialog box.

11. Click the Settings tab. See Figure 3.5.

12. Under Function, arrow, and ctrl keys act as, select Terminal keys.

13. In the Emulation box, select VT100.
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Figure 3.5   Properties Dialog Box

14. Click OK to display the HyperTerminal workspace.

15. Press the Enter key until the main menu appears.

Figure 3.6   Main Menu

If no text or meaningless text appears instead of the Main Menu, adjust
the baud rate in your software. Refer to Troubleshooting Potential
Problems in Chapter 4 for detailed instructions.

TIP: Select File > Save to save the HyperTerminal configuration that
you just created. In future connections, you can select the saved
configuration and quickly connect to the serial converter.

What do you want to do? Page
Edit the serial port rate, or fault action 3-8 through 3-10
View the event queue 4-3
View DF1 data 4-6
Update the firmware C-1

Main Menu - Enter Number for Selection
1> Display Setup Parameters
2> Display Event Queue
3> Flash Upgrade
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To navigate in the terminal emulation software

The serial port rate, sometimes called baud rate or DF1 rate, is the speed
at which the computer and serial converter communicate. You can select
a serial port rate of 9600, 19.2K, or 38.4K with the serial converter
(Series B). The factory-default serial port rate is 9600.

Important: If you change the serial port rate in the serial converter, you
must set your software to use the same serial port rate.

To set the serial port rate

1. Set Parameter 03 - [DF1 Rate Cfg] to the desired rate.

Figure 3.7   DF1 Rate Cfg Parameter in HyperTerminal

2. Reset the serial converter. Refer to Resetting the Serial Converter in
this chapter.

3. Set the serial port rate in your software to match the new serial port
rate in the serial converter.

Key Description
In the main menu, keys 1 – 3 select a menu option.
In the parameter screen, keys 0– 9 enter a value.

Display the main menu or abort changes to a parameter.

Scroll through parameters or events.

Scroll through the values for a parameter.

Save a value for a parameter.

0 9. . .

Esc

OR

OR

Enter

Setting the Serial Port Rate

Press the UP ARROW or DOWN ARROW key to scroll
through the parameter list. Press the LEFT ARROW or
RIGHT ARROW key to modify parameter values. Press
the ENTER key to save a new value.

3> DF1 Rate Cfg = 9600



Configuring the Serial Converter 3-9

By default, when DF1 serial communications are disrupted (e.g., a serial
cable is disconnected) and control I/O is being transmitted, the serial
converter and connected product respond by faulting. You can set the
following actions:

To change the fault action
• Set the value of Parameter 04 - [Comm Flt Action] to the desired

fault action.

Figure 3.8   Comm Flt Action Parameter in HyperTerminal

Changes to this parameter take effect immediately. A reset is not
required.

Setting the Fault Action

Action Description
Fault The product will fault.
Stop The product will stop and not fault (DPI host products only).
Zero data The product is sent 0 for output data after a communications disruption.

This does not command a stop.
Hold last The product continues in its present state after a communications

disruption.

!
ATTENTION: Risk of injury or equipment damage exists.
Parameter 04 - [Comm Flt Action] lets you determine the action of
the serial converter and connected product if communications are
disrupted. By default, this parameter faults the product. You can set this
parameter so that the product continues to run. Precautions should be
taken to ensure that the setting of this parameter does not create a
hazard of injury or equipment damage.

Press the UP ARROW or DOWN ARROW key to scroll
through the parameter list. Press the LEFT ARROW or
RIGHT ARROW key to modify parameter values. Press
the ENTER key to save a new value.

4> Comm Flt Action = Fault
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After you change some parameters, you must reset the serial converter
for the new setting to take effect. You can reset it by removing and then
reapplying power or by using Parameter 05 - [Reset Module].

To reset the serial converter
• Set Parameter 05 - [Reset Module] to either Reset Module or Set

Defaults. “Reset Module” will reset the serial converter. “Set
Defaults” will set all parameters in the serial converter to their
factory-default values.

Figure 3.9   Reset Module Parameter in HyperTerminal

After you enter the “Reset Module” value, the serial converter will be
reset. This parameter will then be reset to “Ready.”

Resetting the Serial Converter

!
ATTENTION: Risk of injury or equipment damage exists. If the serial
converter is transmitting control I/O to the product (indicated by a solid
green diamond LED), the product may fault when you remove or reset
the serial converter. Determine how your product will respond before
removing or resetting a connected serial converter.

Press the UP ARROW or DOWN ARROW key to scroll
through the parameter list. Press the LEFT ARROW or
RIGHT ARROW key to modify parameter values. Press
the ENTER key to save a new value.

5> Reset Module = Reset Module



Chapter 4

Troubleshooting

Chapter 4 provides information to troubleshoot the serial converter.

The serial converter reports its status using status indicators. See Figure
4.1.

Figure 4.1   Status Indicators on the Serial Converter

Topic Page
Understanding the Status Indicators 4-1
Module Diagnostic Items 4-3
Viewing and Clearing the Event Queue 4-3
Viewing and Clearing DF1 Communication Statistics 4-6
Troubleshooting Potential Problems 4-7

Understanding the Status Indicators

# Status Indicator Description Refer To
� Diamond Serial converter status Diamond Status Indicator

on page 4-2
� TX Serial converter is transmitting

data
TX Status Indicator on
page 4-2

� RX Serial converter is receiving
data

RX Status Indicator on
page 4-2

AB

�
�
�
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Diamond Status Indicator

RX Status Indicator

TX Status Indicator

!
ATTENTION: Risk of injury or equipment damage exists. If the serial
converter is transmitting control I/O to the product (indicated by a solid
green diamond LED), the product may fault when you remove or reset
the serial converter. Determine how your product will respond before
removing or resetting a serial converter.

Status Cause Corrective Action
Off Serial converter is not

powered or in Flash
programming mode.

• Securely connect cables.
• Apply power to the product.
• Wait while Flash is in progress.

Flashing
Green

Serial converter is
operating and not
transmitting control I/O.

• No Action. Removing or resetting the serial
converter will not cause a serial fault in the
product.

Solid
Green

Serial converter is
operating and is or was
transmitting control I/O.

• No Action. Removing or resetting the serial
converter may cause a serial fault in the product.
On DPI based products a “Soft Logout” can be
performed allowing removal of the converter
without a fault occurring.
Tip: To remove the adapter without faulting the
drive, set the logic mask in the drive to ignore the
adapter and then verify that the drive is receiving
its Logic Command and Reference from another
source.

Flashing
Red

The product has not
acknowledged the
serial converter.

• Securely connect cables.

Solid
Red

Link Failure. • Securely connect cables.
• Replace the cable.
• Cycle power to the product.

Orange • Contact Rockwell Automation Technical Support.

Status Cause Corrective Action
Off Serial converter is not

receiving data.
• Verify that data is being transmitted.
• Securely connect cables.
• Apply power to the product.

Flashing
Green

Serial converter is
receiving data from the
computer.

• No action.

Status Cause Corrective Action
Off Serial converter is not

transmitting data.
• Verify that data is being transmitted.
• Securely connect cables.
• Apply power to the product.
• Configure the computer software to use the

same serial port rate as the serial converter.
Flashing
Green

Serial converter is
transmitting data to the
computer.

• No action.
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The following diagnostic items can be accessed using DriveExplorer
(version 2.01 or higher).

It is normal for the event queue in the serial converter to contain events.
If you encounter unexpected communication problems, you can access
the event queue and view the most recent events.

To view the event queue

1. Access the event queue using a configuration tool. Refer to
Configuration Tools in Chapter 3.

2. Scroll through events in the event queue. The most recent event can
be found at 2R > Event Queue 1.

Module Diagnostic Items

No. Name Description
1 Common Logic

Cmd
Current value of the Common Logic Command being transmitted
to the host by this peripheral.

2 Prod Logic Cmd Current value of the Product Specific Logic Command being
transmitted to the host by this peripheral.

3 Reference Current value of the Product Specific Reference being
transmitted to the host by this peripheral.

4 Common Logic
Sts

Current value of the Common Logic Status being received from
the host by this peripheral.

5 Prod Logic Sts Current value of the Product Specific Logic Status being received
from the host by this peripheral.

6 Feedback Current value of the Product Specific Feedback being received
from the host by this peripheral.

7 DPI Rx Err Cntr Current value of the DPI CAN Receive Error Counter register.
8 DPI Rx Err Max Maximum value of the DPI CAN Receive Error Counter register.
9 DPI Tx Err Cntr Current value of the DPI CAN Transmit Error Counter register.
10 DPI Tx Err Max Maximum value of the DPI CAN Transmit Error Counter register.
11 Field Flash Cntr Current value of the Field Flash Counter.
12 CPU CPU Type.

Viewing and Clearing the Event Queue
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Figure 4.2   Example Event Queue in HyperTerminal

Events

Many events in the Event queue occur under normal operation. If you
encounter unexpected communications problems, the events may help
you or Allen-Bradley personnel troubleshoot the problem. The following
events may appear in the event queue:

Table 4.A   SCANport Mode

Press the UP ARROW or DOWN ARROW key to scroll
through the parameter list. Press the LEFT ARROW or
RIGHT ARROW key to modify parameter values. Press
the ENTER key to save a new value.

2R> Event Queue 1 = Pin ID Change

Events Description
Adapter Reset The serial converter was reset or power cycled.
Clear SP Fault The SCANport product issued this because a fault was cleared in it.
Clear SP Warning The SCANport product issued this because a warning was cleared.
Empty Queue No event is in the queue.
Message Timeout The DPI product did not respond to a message request. Verify the cables are

correct.
No SCANport Ping The serial converter issued this because no SCANport pings were detected

within a 2 second period. This event may be caused by a broken cable, a broken
serial converter or a malfunction in the SCANport product.

Pin ID Change The serial converter issued this because the SCANport Pin ID was changed.
This event is normal after a power cycled or reset.

SCANport Bus Off The serial converter issued this because its SCANport CAN chip went bus off.
This event may be caused by loose or broken cables or by noise.

SCANport Fault The SCANport product issued this because it was faulted. See its fault queue.
SCANport Reset The SCANport product issued this because it was reset.
SCANport Warning The SCANport product issued this because it had a warning.
SP Pin ID = 7 The serial converter issued this because its Pin ID has a value of 7. It should

have a value between 1 and 6. This event may be caused by a loose or broken
cable.
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Table 4.B   DPI Mode

To clear the event queue

1. Access the event queue using a configuration tool. Refer to
Configuration Tools in Chapter 3.

2. Set the value of 1 > Clr Event Queue to Enable, and then press
Enter to clear the event queue.

Figure 4.3   Reset Event Queue in HyperTerminal

Events Description
Bad Host Flt The serial converter was connected to an incompatible product.
Control Disabled The serial converter has sent a “Soft Control Disable” command to the DPI

product.
Control Enabled The serial converter has sent a “Soft Control Enable” command to the DPI

product.
DPI Bus Off Flt A bus-off condition was detected on DPI. This event may be caused by loose or

broken cables or by noise.
DPI Fault Clear A DPI product has issued a fault clear message.
DPI Fault Msg The drive entered a faulted state.
Dup. Port Flt Another peripheral with the same port number is already in use.
EEPROM Sum Flt The EEPROM in the serial converter is corrupt.
Host Sent Reset The DPI product issued this because it was reset.
Message Timeout The DPI product did not respond to a message request. Verify the cables are

correct.
No Event Empty event queue entry.
Normal Startup Adapter initially powered up or was reset.
Online @ 125kbps The serial converter and DPI product are communicating at 125kbps.
Online @ 500kbps The serial converter and DPI product are communicating at 500kbps.
PCCC I/O Time Flt The serial converter has not received a PCCC Control message for longer than

the specified PCCC Control Time-out.
Ping in Message An unexpected ping was received.
Ping Time Flt A ping message was not received on DPI within the specified time.
Port Change Flt The DPI port changed.
Port ID Flt The serial converter is not connected to a correct port on a DPI product.
Type 0 Login The serial converter has logged in for type 0 control.
Type 0 Time Flt The serial converter has not received a type 0 status message within the

specified time.
Use I/O Sent The serial converter has begun sending product specific control information.

Press the UP ARROW or DOWN ARROW key to scroll
through the parameter list. Press the LEFT ARROW or
RIGHT ARROW key to modify parameter values. Press
the ENTER key to save a new value.

1> Clr Event Queue = Enable
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If you encounter unexpected communications problems or are creating
an application that uses DF1 data, you can view the communications
statistics in the serial converter. Parameters 06 through 15 store this data.

In order to view and clear DF1 data, you must access the main menu in
the serial converter firmware. Refer to Configuration Tools in Chapter 3.

To view DF1 data

1. Access the parameters in the serial converter using a configuration
tool. Refer to Configuration Tools in Chapter 3.

2. Scroll through the DF1 parameters. Parameters 06 through 15
contain DF1 data. For a description of each parameter, refer to
Appendix B, Serial Converter Parameters.

Figure 4.4   Example Parameter Display in HyperTerminal

To clear DF1 data

1. Access the parameters in the serial converter using a configuration
tool. Refer to Configuration Tools in Chapter 3.

2. Set the value of Parameter 6 - [Clear DF1 Counts] to Clear
Counts, and then press Enter to clear the DF1 data.

Figure 4.5   Example Parameter Display in HyperTerminal

Viewing and Clearing DF1 Communication Statistics

Press the UP ARROW or DOWN ARROW key to scroll
through the parameter list. Press the LEFT ARROW or
RIGHT ARROW key to modify parameter values. Press
the ENTER key to save a new value.

7R> DF1 Packets Sent = 0

Press the UP ARROW or DOWN ARROW key to scroll
through the parameter list. Press the LEFT ARROW or
RIGHT ARROW key to modify parameter values. Press
the ENTER key to save a new value.

6> Clear DF1 Counts = Clear Counts
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Troubleshooting Potential Problems

Description Action
You are unable to establish a
connection between your computer
and the serial converter.

• If the status indicators are off, connect the
cables and apply power to the product.

• Configure your software and serial converter
to use the same serial port rate (baud rate).

After changing the serial port rate,
you are no longer able to
communicate with the serial
converter and connected product.
For example, in HyperTerminal,
meaningless text appears on the
screen when you press Enter. In
DriveExplorer, parameter values are
not updated.

Reset the serial port rate in the software.
Instructions are included here for resetting the
serial port rate in HyperTerminal and
DriveExplorer. If you are using a different
configuration tool, refer to its user manual.
HyperTerminal
1. Select File > Properties, and then click

Configure.
2. Select the new baud rate, and then click OK.
3. Save and close HyperTerminal.
4. Double-click on your HyperTerminal file (*.ht)

to restart HyperTerminal.
5. Press Enter until the main menu appears.
DriveExplorer
1. Select Explore > Configure

Communication.
2. Select the new baud rate. DriveExplorer

should start updating values again. If it does
not, restart DriveExplorer.

You set a new serial port rate, but the
serial converter is still using the old
serial port rate.

• Reset the adapter. Refer to Chapter 3,
Configuring the Serial Converter.

You are using either DriveExplorer
v1.xx or DriveTools32 v2.xx and you
can not perform any of the following:
1. Route out over a network, such

as DeviceNet to another drive.
2. Access DPI peripherals such as

the 20-COMM-D DeviceNet
adapter.

3. Access 32-bit data.

Normal operation. These features require either:
• DriveExplorer v2.xx or greater.
• DriveTools 2000 v1.xx or greater.

You are using either DriveExplorer
v2.xx (or greater) or DriveTools 2000
v1.xx (or greater) and you can not
perform any of the following:
1. Route out over a network, such

as DeviceNet to another drive.
2. Access DPI peripherals such as

the 20-COMM-D DeviceNet
adapter.

3. Access 32-bit data.

• Check the 1203-SSS firmware version – you
must have FRN 3.xxx or greater.

• Parameter 16 - [Interface Select] must be set
to “Auto.”

• Reset the converter. See Resetting the Serial
Converter in Chapter 3.
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Notes:



Appendix A

Specifications

Appendix A provides the specifications for the serial converter.

Topic Page Topic Page
Communications A-1 Environmental A-2
Electrical A-1 Regulatory Compliance A-2
Mechanical A-1

Communications

Network
Protocol
Port Rate
Data Bits
Parity
Stop Bits
Flow Control
Error

RS-232 Serial DF1, Full Duplex
9600, 19.2K, or 38.4K
8
None
1
None
CRC or BCC (Auto-Detected)

Product
Protocol
Data Rates

SCANport: 125K
DPI: 125K/500K

Electrical

Consumption 130mA at +12V DC
The serial converter draws the required power
from the connected product. An external power
source is not required.

Mechanical

Dimensions 103.5 x 73.4 x 23.6 mm (4.08 x 2.89 x 0.93 in.)
Weight 70.88 g (2.5 oz.)
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Environmental

Temperature
Operating
Storage

0 to +50°C (32 to 122°F)
-40 to +85°C (-40 to 185°F)

Relative Humidity 5 to 95% non-condensing
Vibration

Operating
Non-Operating

2.5G @5Hz-2KHz
5 G @5Hz-2KHz

Shock
Operating
Non-Operating

30 G peak acceleration, 11(+/-1)ms pulse width
50 G peak acceleration, 11(+/-1)ms pulse width

Regulatory Compliance

UL
CE

508C and CUL
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Serial Converter Parameters

This chapter presents information about the parameters in the serial
converter.

Parameter List

No. Name and Description Details
01 [Adapter Port]

Port on the host product to which the serial converter is
connected.

Default: 0
Minimum: 0
Maximum: 7
Type: Read Only

02 [DF1 Addr Cfg]
DF1 node address for the serial converter. This is a
decimal value.

Default: 1
Minimum: 0
Maximum: 254
Type: Read/Write
Reset Required: Yes

03 [DF1 Rate Cfg]
Serial port rate for the DF1 serial port on the serial
converter.

Default: 0 = 9600
Values: 0 = 9600

1 = 19.2K
2 = 38.4K

Type: Read/Write
Reset Required: Yes

04 [Comm Flt Action]
Action that the serial converter and product take if the
serial converter detects that DF1 serial
communications are disrupted. This setting is effective
only if control I/O is transmitted through the serial
converter.

Default: 0 = Fault
Values: 0 = Fault

1 = Stop (DPI) or
Fault (SCANport)
2 = Zero Data
3 = Hold Last

Type: Read/Write
Reset Required: No

!
ATTENTION: Risk of injury or equipment damage exists. Parameter 04 -
[Comm Flt Action] lets you determine the action of the serial converter and
connected product if communications are disrupted. By default, this
parameter faults the product. You can set this parameter so that the product
continues to run. Precautions should be taken to ensure that the setting of
this parameter does not create a hazard of injury or equipment damage.
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No. Name and Description Details
05 [Reset Module]

Ready No action.
Reset Module Resets the serial converter.
Set Defaults Restores the serial converter to its

factory-default settings.
This parameter is a command. It will be set to “Ready”
after a “Reset Module” command or “Set Defaults”
command has been performed.

Default: 0 = Ready
Values: 0 = Ready

1 = Reset Module
2 = Set Defaults

Type: Read/Write

06 [Clear DF1 Counts]
No action if set to “Ready.” Resets the DF1 statistical
parameters (numbers 07 – 15) to 0 if set to “Clear
Counts.” This parameter is a command. It will be reset to
“0 = Ready” after a “Clear Counts” command has been
performed.

Default: 0 = Ready
Values: 0 = Ready

1 = Clear Counts
Type: Read/Write

07 [DF1 Packets Sent]
Number of DF1 packets sent by the serial converter. The
value of this parameter is normally approximately equal to
the value of Parameter 08 - [DF1 Packets Rcvd].

Default: 0
Minimum: 0
Maximum: 4294967295
Type: Read Only

08 [DF1 Packets Rcvd]
Number of DF1 packets received by the serial converter.
The value of this parameter is normally approximately
equal to the value of Parameter 07 - [DF1 Packets Sent].

Default: 0
Minimum: 0
Maximum: 4294967295
Type: Read Only

09 [Undelivered Msgs](1)

Number of DF1 messages that were sent but not
acknowledged.

Default: 0
Minimum: 0
Maximum: 65535
Type: Read Only

10 [ENQs Sent](1)

Number of ENQ characters sent by the serial converter.
Default: 0
Minimum: 0
Maximum: 65535
Type: Read Only

11 [ENQs Received](1)

Number of ENQ characters received by the serial
converter.

Default: 0
Minimum: 0
Maximum: 65535
Type: Read Only

12 [NAKs Received](1)

Number of NAK characters received by the serial
converter.

Default: 0
Minimum: 0
Maximum: 65535
Type: Read Only

13 [NAK Bad Packet](1)

Number of NAKs sent by the serial converter because of
corrupt packets (improper protocol messages) as
determined by the serial converter.

Default: 0
Minimum: 0
Maximum: 65535
Type: Read Only

(1) This value is normally a low value. If it is continually incrementing and you are having
communications problems, use a lower baud rate or replace the 1203-SFC serial cable.

!
ATTENTION: Risk of injury or equipment damage exists. If the serial
converter is transmitting control I/O to the product (indicated by a
solid green diamond LED), the product may fault when you remove
or reset the serial converter. Determine how your product will
respond before removing or resetting a connected serial converter.
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No. Name and Description Details
14 [NAK No Memory](1)

Number of NAKs sent by the serial converter because it
did not have sufficient memory to buffer the incoming
messages. The serial converter runs out of memory if a
command has not completed and there is no place to
save the new commands.

Default: 0
Minimum: 0
Maximum: 65535
Type: Read Only

15 [Duplicate Msgs](1)

Number of duplicate messages sent by the serial
converter. This value contains the total number of
consecutive messages received by this device with the
same TNS (Transaction Sequence) number.

Default: 0
Minimum: 0
Maximum: 65535
Type: Read Only

16 [Interface Select]
Auto Converter will automatically run DPI if

connected to a DPI product or SCANport if
connected to a SCANport product.

SCANport Converter will perform SCANport services
only.

Set this parameter to “Auto” (default) unless you are using
DriveExplorer v1.xx or DriveTools32 v2.xx software and
you are connected to a DPI product. Use “SCANport” for
these software versions.

Default: 0 = Auto
Values: 0 = Auto

1 = SCANport
Type: Read/Write

17 [DPI Data Rate](2)

Data rate used by the DPI host product. This data rate is
set in the drive, and the adapter autobauds to it.

Default: 0
Values: 0 = 125 kbps

1 = 500 kbps
Type: Read Only

18 [DF1 Addr Actual](2)

DF1 address actually used by the serial converter.
Default: 1
Minimum: 0
Maximum: 254
Type: Read Only

19 [DF1 Rate Actual](2)

Serial port rate actually used for the DF1 serial port on the
serial converter.

Default: 0 = 9600
Values: 0 = 9600

1 = 19.2K
2 = 38.4K

Type: Read Only
20 [Ref/Fdbk Size](2)

Size of the Reference/Feedback. The host product
determines the size of the Reference/Feedback. The
serial converter automatically uses the correct size.

Default: 0 = 16-bit
Value: 0 = 16-bit

1 = 32-bit
Type: Read Only

21 [Datalink Size](2)

Size of each Datalink word. The host product determines
the size of Datalinks.

Default: 0 = 16-bit
Values: 0 = 16-bit

1 = 32-bit
Type: Read Only

(1) This value is normally a low value. If it is continually incrementing and you are having
communications problems, use a lower baud rate or replace the 1203-SFC serial cable.

(2) The parameter appears only when the serial converter is connected to a product implementing
DPI.
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Notes:
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Flash Updates

Appendix C provides information on updating DPI host or peripheral

product firmware.

Please take the following precautions to ensure a successful Flash:

• Obtain the new firmware version from Rockwell Automation. Save it
to the hard drive of the computer. Do not attempt to perform a Flash
from a floppy disk or a network.

• Read all instructions supplied with the new firmware file.

• Use a computer running terminal emulation software that supports
Xmodem transfers (e.g., HyperTerminal). In this manual, we show
how to use HyperTerminal.

• Record parameter values in the device that will be flashed. Updates
may reset parameters to their default settings.

• Ensure that the DPI host product (i.e. PowerFlex 70) is stopped.

• Close all programs except the terminal emulation program that you
are using to Flash the serial converter.

• Disable the screen saver and antivirus programs so that they do not
start during the Flash.

• If you are using a laptop computer, turn off the FIFO buffers in
HyperTerminal. In HyperTerminal, select File > Properties to
display the Properties dialog box. Click Configure, and then click
Advanced. Ensure that a check mark does not appear next to Use
FIFO buffers.

• Verify that Parameter 16 - [Interface Select] is set to “Auto”
(default).

Topic Page
Preparing for a Flash Update C-1
Performing a Flash Update with
HyperTerminal

C-2

Troubleshooting Potential Flash Problems C-4

Preparing for a Flash Update



C-2 Flash Updates

1. In the main menu (Figure 3.6), press 3 to Update Flash program.

If the serial converter is connected to a product implementing
SCANport, you can only update the firmware in the serial converter.
The screen in Figure C.2 will immediately appear.

If the serial converter is connected to a product implementing DPI, a
menu appears for you to select the device that you want to update.

Figure C.1   Example DPI Flash Menu

After you select a device by typing its number, a line appears to
confirm that you selected the right device (for example, “You have
chosen to update -- 2 > This 1203-SSS”) and the following text
appears:

Figure C.2   Flash Menu

Performing a Flash Update with HyperTerminal

Flash Upgrade. Enter Number for Selection.
0 > PowerFlex 70
1 > LCD HIM
2 > This 1203-SSS
5 > 20-COMM-D

To update the Flash memory, you need a terminal
program capable of downloading a binary file using
the XMODEM protocol and a Flash update file from
Rockwell Automation. When you press 'Y' to signal
that you are ready to proceed, the terminal program
will start displaying the letter 'C'. This signals
the XMODEM protocol that the download may proceed.
You then have one minute to start the transfer.
Press CTRL-X to cancel an update started by
mistake. Are you ready to proceed? (Y/N)

!
ATTENTION: Hazard of injury or equipment damage exists. When
you perform a Flash update, the product will fault if it is receiving
control I/O from the serial converter. Verify that the product has
stopped safely or is receiving control I/O from an alternate source
before beginning a Flash update.

!
ATTENTION: Hazard of equipment damage exists. If you interrupt a
flash procedure that is updating boot code, the device may become
inoperable. To prevent this damage, follow the instructions provided
with the new firmware file and do not interrupt a flash procedure while
boot code is being flashed.
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2. If the Flash can be completed safely, type Y. The letter “C”
repeatedly appears. It is the Xmodem prompt and continues to
appear until you send a binary file.

Important: Press Ctrl + X to cancel a Flash update procedure.

3. Select Transfer > Send File to display the send file dialog box.

4. Click Browse and navigate to the Flash file.

5. Double-click the file. Its name appears in the Filename box.

6. In the Protocol box, select Xmodem.

Figure 4.6   Example Send File Dialog Box

7. Click Send. A dialog box appears and reports the progress of the
download. When it is complete, the message “Operation Complete”
appears.

Important: Keep the device powered for 15 seconds after the operation
has completed.

8. Press the Enter key to return to the main menu.
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Troubleshooting Potential Flash Problems

Description Corrective Action
“Transfer Cancelled by Remote
System” message appears and the
Flash is not completed.

• Restart HyperTerminal and repeat the Flash
procedure.

• If you are using Windows NT 4.0, install SP3
or later. Windows NT service packs are
available from the Microsoft web site:
http://www.microsoft.com.

• Download a HyperTerminal Private Edition
update from the Hilgraeve web site:
http://www.hilgraeve.com.
(Please note that there is a license
requirement with this software.) Then,
perform the Flash procedure again.

The “Xmodem File Send” for dialog
box appears, but the Flash file is not
transferred.

• Verify that you have selected the Xmodem
protocol in the Send file dialog box.

• Verify that the new file is on your hard disk.
Do not attempt to Flash from a floppy disk or
a network.

• Verify that you are sending the file within 60
seconds of pressing Y to confirm that you
want to perform the Flash.

After completing a Flash, you are
unable to communicate with the serial
converter. For example, meaningless
text appears on the HyperTerminal
screen.

• Set the serial port rate to 9600. If parameters
are changed during a Flash update, all
parameters are set to their default settings.

You are unable to initiate a Flash to a
DPI host or peripheral product.

• Verify that Parameter 16 - [Interface Select]
is set to “Auto” (default setting).
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A Application Code

Code that runs in the adapter after the boot code calls it. It performs the
normal operations of the system.

B BCC

Block Check Character. An error detection scheme where the 2’s
complement of the 8-bit sum (modulo-256 arithmetic sum) of all data
bytes in a transmission block. It provides a means of checking the
accuracy of each message transmission.

Boot Code

Code that runs when the adapter first receives power. It checks basic
operations and then calls the application code.

Bus Off

A bus off condition occurs when an abnormal rate of errors is detected
on the Control Area Network (CAN) bus in a device. The bus-off device
cannot receive or transmit messages. This condition is often caused by
corruption of the network data signals due to noise or data rate
mismatch.

C CRC

Cyclic redundancy check. An error detection scheme where all of the
characters in a message are treated as a string of bits representing a
binary number. This number is divided by a predetermined binary
number (a polynomial) and the remainder is appended to the message as
a CRC character. A similar operation occurs at the receiving end to prove
transmission integrity.

D DF1 Protocol

A peer-to-peer link layer protocol that combines features of ANSI
X3.28-1976 specification subcategories D1 (data transparency) and F1
(two-way simultaneous transmission with embedded responses).

DF1 Rate

A unit of signaling speed equal to the number of discrete conditions or
signal events per second. It is also called “baud rate” or “serial port rate.”
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DPI

DPI is a second generation peripheral communication interface used by
various Allen-Bradley drives and power products. It is a functional
enhancement to SCANport.

DPI Peripheral

A device that provides an interface between DPI and a network or user.
Peripheral devices are also referred to as “adapters” and “modules.” The
serial converter and PowerFlex HIM are examples of DPI peripherals.

DPI Product

A device that uses the DPI communications interface to communicate
with one or more peripheral devices. For example, a motor drive such as
a PowerFlex drive is a DPI product. In this manual, a DPI product is also
referred to as “product” or “host.”

DriveExplorer

An easy-to-use software application designed for Microsoft
Windows 95, Windows 98, Windows NT (4.0 or greater), and Windows
CE (2.0 or greater) operating systems. To fully utilize DPI products, use
DriveExplorer version 2.xx or greater. SCANport products work with all
versions of DriveExplorer. This application is a tool for monitoring and
configuring Allen-Bradley products and adapters. A free version of
DriveExplorer Lite is included with the serial converter. Information
about DriveExplorer can be accessed at http://www.ab.com/drives/
driveexplorer.

DriveTools

A software suite designed for Microsoft Windows 95, Windows 98, and
Windows NT (4.0 or greater) operating systems. To fully utilize DPI
products, use DriveTools 2000 version 1.xx or greater. SCANport
products work with all versions of DriveTools32 (or DriveTools 2000).
This software suite provides a family of tools that you can use to
program, monitor, control, troubleshoot, and maintain Allen-Bradley
products. Information about DriveTools can be accessed at http://
www.ab.com/drives.

F Flash Update

The process of updating firmware in a device.
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H HIM (Human Interface Module)

A device that can be used to configure and control a PowerFlex drive.
New HIMs (20-HIM-x) can be used to configure connected peripherals
such as the serial converter.

Hold Last

When communications are disrupted (e.g., serial cable is disconnected),
the converter and product can respond by holding last state. Hold last
state results in the product receiving the last data received via the DF1
connection before the disruption. If the product was in RUN mode and
using the Reference from the converter, it will continue to run at the
same Reference.

N Non-Volatile Storage (NVS)

NVS is the permanent memory of a device. Devices such as the
converter store parameters and other information in NVS so that they are
not lost when the device loses power. NVS is sometimes called
“EEPROM.”

P PCCC (Programmable Controller Communications Command)

PCCC is the protocol used by some controllers to communicate with
devices on a network. Some software products (for example,
DriveExplorer and DriveTools 2000) also use PCCC to communicate.

Ping

A ping is a message that is sent by a DPI product to its peripheral
devices. They use the ping to gather data about the product, including
whether it can receive messages and whether they can log in for control.

S SCANport

A peripheral communications interface for various Allen-Bradley drives
and power products.

SCANport Peripheral Device

A device that provides an interface between SCANport and a network or
user. Peripheral devices are also referred to as “adapters” and “modules.”
The serial converter and HIM are examples of SCANport peripherals.
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SCANport Product

A device that uses the SCANport communications interface to
communicate with one or more peripheral devices. For example, a motor
drive such as a 1336 PLUS II is a SCANport product. In this manual, a
SCANport product is also referred to as “product.”

Serial Converter

The serial converter provides an electronic communications interface
between any Allen-Bradley SCANport/DPI product and a computer with
an RS-232 port. This converter uses a full-duplex RS-232 DF1 protocol.
The serial converter may also be referred to as “1203-SSS converter,”
“converter,” “DPI peripheral,” or “SCANport peripheral.”

Status Indicators

Status indicators are LEDs that are used to report the status of a device.
There are three status indicators on the converter.

T Type 0/Type 1/Type 2 Control

When transmitting I/O, the adapter can use different types of messages
for control. The Type 0, Type 1, and Type 2 events help Allen-Bradley
personnel identify the type of messages that an adapter is using.

X Xmodem

Developed by Ward Christensen in 1978, Xmodem is a protocol used to
transfer data. You can use the Xmodem protocol to flash the firmware in
the serial converter or a device connected to it.

Z Zero Data

When communications are disrupted (e.g., serial cable is disconnected),
the converter and product can respond with zero data. Zero data results
in the product receiving zero as values for command data. If the product
was in RUN mode and using the Reference from the converter, it will
stay in run mode but at zero Reference.
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Notes:
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Notes:
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Numerics
1203-SSS converter, see serial

converter

A
accessing parameters, 3-1

Adapter Port parameter, B-1

adapter, see serial converter

application code, G-1

attentions, 1-4

B
baud rate, refer to DF1 rate

BCC, A-1, G-1

boot code, G-1

bus off, G-1

C
cables

connecting, 2-2
disconnecting, 2-2
selecting, 2-1

catalog numbers, 1-1

checksum, A-1

Clear DF1 Counts parameter, B-2

clearing DF1 data, 4-6

clearing events, 4-5

Comm Flt Action parameter, B-1

communications specifications, A-1

compatible products, 1-2

components, 1-1

converter, see serial converter

CRC, A-1, G-1

D
data bits, A-1

Datalink Size parameter, B-3

DF1
definition, G-1
viewing data, 4-6

DF1 Addr Actual parameter, B-3

DF1 Addr Cfg parameter, B-1

DF1 Packets Rcvd parameter, B-2

DF1 Packets Sent parameter, B-2

DF1 rate
definition, G-1
setting, 3-8
specification, A-1

DF1 Rate Actual parameter, B-3

DF1 Rate Cfg parameter, B-1

Diamond status indicator, 4-2

dimensions, A-1

DPI
cables, 2-1, 2-2
definition, G-2
peripheral, G-2
products, 1-2, G-2

DPI Data Rate parameter, B-3

DriveExplorer
definition, G-2
documentation, P-1
free lite version, G-2
using, 3-3

drives, see SCANport or DPI
products

DriveTools
definition, G-2
documentation, P-1

Duplicate Msgs parameter, B-3
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E
EEPROM, refer to Non-Volatile

Storage (NVS)

ENQs Received parameter, B-2

ENQs Sent parameter, B-2

equipment
required, 1-3
supplied, 1-3

error detection, A-1

event queue
clearing events, 4-5
list of events, 4-4
viewing events, 4-3

events
clearing, 4-3
viewing, 4-3

F
fault action, 3-9

fault queue, refer to event queue

faults, refer to events

firmware
parameters in, 3-1
release, P-1
updating, C-1

Flash update
definition, G-2
instructions, C-1
troubleshooting, C-4

flow control, A-1

FRN, P-1

H
Handheld PC, 2-1

HIM (Human Interface Module)
definition, G-3
using, 3-2

hold last
definition, G-3
setting, 3-9

HPC, 2-1

HyperTerminal
navigating in, 3-8
setting up, 3-4
updating firmware with, C-4

I
installing a serial converter, 2-2

Interface Select parameter, B-3

K
keys, 3-8

L
LCD HIM, 3-2

LED HIM, 3-2

LEDs, refer to status indicators

M
main menu, 3-7

manual conventions, P-1

mechanical specifications, A-1

N
NAK Bad Packet parameter, B-2

NAK No Memory parameter, B-3

NAKs Received parameter, B-2

navigating in the firmware, 3-8

Non-Volatile Storage (NVS)
definition, G-3
parameters in, 3-1
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P
parameters

accessing, 3-1
list of, B-1–B-3
manual conventions, P-1

parity, A-1

PCCC, G-3

ping, G-3

power consumption, A-1

power cycle, 3-10

products, see SCANport or DPI
products

protocol, A-1

Q
quick start, 1-5

R
Ref/Fdbck Size parameter, B-3

regulatory compliance, A-2

related documentation, P-1

removing a serial converter, 2-2

Reset Module parameter, B-2

resetting the converter, 3-10

RX status indicator, 4-2

S
safety precautions, 1-4

SCANport
cables, 2-1, 2-2
definition, G-3
peripheral, G-3
products, 1-2, G-4

serial cables, 2-1, 2-2

serial converter
accessing, 3-1
components, 1-1
definition, G-4
event queue, 4-3
features, 1-2
illustration, 1-1
installing, 2-2
parameters, B-1–B-3
removing, 2-2
resetting, 3-10

serial port rate, refer to DF1 rate

Soft Logout, 1-6, 4-2

specifications, A-1

status indicators
definition, G-4
operating status, 4-1
troubleshooting with, 4-2

stop bits, A-1

T
technical support, P-2

terminal emulation software, 3-1, 3-4

tools, see equipment

troubleshooting, 4-1

TX status indicator, 4-2

U
Undelivered Msgs parameter, B-2

update, see Flash update

V
viewing DF1 data, 4-6

VT100-compatible terminal, 3-1

W
web sites, P-1, G-2



Index-4

X
Xmodem

definition, G-4
using to flash firmware, C-1

Z
zero data

definition, G-4
setting, 3-9



1336 FORCE, 1336 IMPACT, Allen-Bradley, DPI, DriveExplorer,
DriveTools 2000, DriveTools32, PowerFlex, SCANport, and SMC
Dialog Plus are trademarks of Rockwell Automation.

DeviceNet is a trademark of the Open DeviceNet Vendor Association.

ControlNet is a trademark of ControlNet International Ltd.

Windows, Windows CE, Windows NT, and Microsoft are either
registered trademarks or trademarks of Microsoft Corporation.
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